Curriculum & Technology Integration Training

Tropical Trek

Get to know your classmates. See if you can find someone who has done each of
the things listed below. Get them to initial your squares. Remember only one person

per square.

Good Luck!

Has been to Zoo
Atlanta this year.

Ever owned a
parrot.

Been to South
America.

Eaten a guava.

Eaten a mango.

Drinks more than 3
cups of coffee a

can name 3
products from the
rain forest.

Owns something
made of mahogany.

day.
Can name 3 animals Has cracked open a
that live in the Has rattan Has seen passion P
. . . coconut.
rainforest. furniture. fruit.

Owns an African

Got an orchid for

Bought new tires in
the last month.

Has varnished
furniture in the last

violet. Easter. year-
Stepped in gum Planted a-rree this Held a snake. Picked bananas.
lately. spring.

Owned a reptile.

Has a rubber plant.

Has a butterfly
collection.

Has talked to
students about the
rainforest.
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Statement of Beliefs

We Believe....

o That great curriculum + effective methods = better student achievement

e It doesn't matter how much technology you have, its what you do with it that counts
o That instruction should be a blend of whole group, small group and individualized

e Coaching is more powerful than lecturing

o That all students can be reached with the right tools

o That assessment should be frequent, individualized and relevant

o That competition can only get you so far, but the rewards of cooperation are limitless
o Inasking what strengths a student has first before discovering the deficits

o Shifting from the primacy of verbal thinking to the integration of visual, verbal and
kinesthetic learning

Day 1 inspiring, innovative, instruction Copyright © 2006 i3 Inc.



Curriculum & Technology Integration Training -3-

Rainforests around the World

Teaching
Strategies
Modeled

Technology
Strategies
Modeled

Instruction
Essential Questions for Teachers:
Can I effectively use one computer as an instructional tool in my classroom?
How do T determine if the use of technology is affective?

Essential Question:

What is a rainforest? Where are Rainforests located? How
might the ecosystem enhance and or dictate the culture? How
might the culture impact the ecosystem?

Learning Standards:

Social Studies Standards

All students will conduct investigations by formulating a clear
statement of a question, gathering and organizing information
from a variety of sources, analyzing and interpreting information,
formulating and testing hypotheses, reporting results both orally
and in writing, and making use of appropriate technology.

All students will describe and compare characteristics of
ecosystems, states, regions, countries, major world regions, and
patterns and explain the processes that created them.

All students will describe, compare, and explain the locations and
characteristics of ecosystems, resources, human adaptation,
environmental impact, and the interrelationships among them.

English/Language Arts Standard

All students will read and comprehend general and technical
material. All students will demonstrate the ability to write clear
and grammatically correct sentences, paragraphs, and
compositions. All students will focus on meaning and
communication as they listen, speak, view, read, and write in
personal, social, occupational, and civic contexts.

Materials:

Teacher created PowerPoint, Computer with Internet Connection,
Google Earth, Encarta Atlas or other electronic atlas software,
united streaming video video, student handouts.

Day 1
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Computers in
the Classroom-
Gateways to
Communication
and Learning
http://www.te

chlearning.com
/db_area/arch

ives/WCE/arc
hives/norris2.
htm

Whole Group
Instruction

Pair/Share

Whole Group
Instruction

Whole Group
Instruction

VCR/Video

Electronic
Encyclopedia

Virtual Globe
Google Earth

Technology Connections:

Students will watch a video to gather background knowledge,
gather information from a electronic atlas and a Web site, view a
teacher-created PowerPoint presentation, use Inspiration to
organize collected data, and use word processing software to
participate in a synergized writing activity.

Procedures:

Large Group Activity:

Instructor will introduce the concept of how different
ecosystems might dictate or influence the culture of an area by
talking to students about their personal histories,
neighborhoods, religions, and family traditions.

Large Group Activity:

1. Students will view and listen to video clip to determine
characteristics and locations of rainforests. They will collect
facts on their note sheet.

2. Students will view Encarta Atlas, Google Earth to locate
continents, equator, Tropic of Cancer, Tropic of Capricorn,
and countries where rainforests can be found.

3. Instructor models use of basic word processing in Microsoft
Word as participants offer sentences, which synthesize all
group information in response to question, "Where in the
World are we?"

Individual Activity:

1. Students will create a legend on the July Precipitation data
collection sheet to include: equator, Tropic of Cancer, Tropic
of Capricorn, colors for rainfall measurements.

2. Students will shade and label the rainfall in South America,
Africa, and Indonesia

3. Students will create a legend on the July Temperature data
collection sheet to include: equator, Tropic of Cancer, Tropic
of Capricorn, colors for temperature measurements.

4. Students will shade and label the temperatures in South
America, Africa and Indonesia.

5. Students will share information from mapping activity.

6. Students will use Encarta Encyclopedia and Virtual Globe to
locate at least three facts on Bali Islands, Indonesia. List
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Inspiration,

Scan
Converter

Scan
Converter

PowerPoint

Internet-

information on the Rain Forest map sheet.

Students will organize preliminary facts about rainforests and
specific facts about Indonesia on an Inspiration graphic
organizer. From that they will create an outline in Inspiration,
to use for a writing activity.

Large Group Activity:

1.

Introduce the 3-rainforest locations we will be investigating.
Instruct students on how to utilize the hyperlinks in the
PowerPoint so they can use them for self guided exploration
and research on the ecosystems and cultures.

Students will use fact-gathering sheet to collect specific
data during the Power Point presentation.

. Ask students to help you use that information to write a class

paragraph. Give one student a blow-up globe. Ask that
student to tell you a beginning sentence for the paragraph.
Type the sentence into a new document in Student Writing
Center. The first student passes the globe to someone else
who gives you the second sentence. Keep passing the globe
until you have enough sentences for your rough draft.

When you have finished the paragraph, explain that you are
going to begin the revision process. Ask students to help
identify any sentences that don't belong or are not in the
right order. Make changes upon students’ suggestions and
have them fo continue to pass the globe.

When all revisions have been made, explain that you are going
to start the editing stage. Ask students to help you identify
any misspelled words or mistakes in punctuation and
capitalization. Make sure that all students have received the
globe and have had a chance to participate in the writing
process by the end of this stage.

Now give each student a storyboard. Ask students to write
their own paragraph about what they have learned about
rainforests.

Assign each student a peer editor with whom they will
exchange papers. Give each editor a checklist to use as they
check their partner's papers for mistakes.

After editing, allow students to publish their writing using
Student Writing Center or Microsoft Word. Allow students
to go to the Rainforest Image Folder to pick an image for
their paragraph.

Day 1
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9. Students will change font, style, color, and alignment.
10. Students will use spell check.
11. Allow students fo print their work and share it with a peer.

Assessment: Students will be assessed on their answers on the
Fact Gathering Sheet, completed maps and writing activity.

Day 1
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Rainforest Facts
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Defining & Locating Regions
Precipitation Map
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Defining & Locating Regions
Temperature Map
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Writing Activity

Teaching | Technology Instruction
Strategies | Strategies | Essential Questions for Teachers: How do I use the outline feature of
Modeled Modeled | Inspiration? How do I collect and use graphics from the Internet? What are
the steps in the Writing Process?
Essential Question:
ABC's of the . .
Writing What have I learned about Rainforests? Can I write a paragraph
Process stating what I've learned?
http://www.
angelfire.co . " .
o/ wi/writin Lear'.nmg Standards (State of Michigan):
gprocess/ English/Language Arts Standards

All students will read and comprehend general and technical
material. All students will demonstrate the ability to write clear
and grammatically correct sentences, paragraphs, and
compositions. All students will focus on meaning and
communication as they listen, speak, view, read, and write in
personal, social, occupational, and civic contexts.

All students will define and investigate important issues and
problems using a variety of resources, including technology, to
explore and create texts.

All students will demonstrate, analyze, and reflect upon the skills
and processes used o communicate through listening, speaking,
viewing, reading, and writing.

Materials:
Student Writing Center or Microsoft Word, Inspiration,
Internet, blow-up globe, world map

Technology Connections:
Students will use the facts they gathered in their Inspiration
Web to create an outline. They will use that outline to write
using their draft storyboard and then word process in Student
Writing Center or Microsoft Word. Students will collect a
graphic from the Internet to use in their project.
Procedures:

1. Review the rainforest information that students learned in

the previous lesson.
2. Show students the class Inspiration Web that was created

Day 1
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Whole
Group
Instruction

Whole
Group
Synergized
Writing
Activity

Individual
Work

Partner
Activity

Individual
Work

Inspiration
Scan
Converter

Student
Writing
Center or MS
Word

Scan
Converter

and review the information written in each field.

Using Inspiration to create an outline.

4. Ask students to help you use that information to write a
class paragraph. Give one student a blow-up globe. Ask
that student to tell you a beginning sentence for the
paragraph. Type the sentence info a new document in
Student Writing Center. The first student passes the
globe to someone else who gives you the second sentence.
Keep passing the globe until you have enough sentences for
your rough draft.

5. When you have finished the paragraph, explain that you
are going to begin the revision process. Ask students to
help identify any sentences that don't belong or are not in
the right order. Make changes upon students’' suggestions
and have them to continue to pass the globe.

6. When all revisions have been made, explain that you are
going to start the editing stage. Ask students to help you
identify any misspelled words or mistakes in
punctuation/capitalization. Make sure that all students
have received the globe and have had a chance to
participate in the writing process by the end of this stage.

7. Now give each student a storyboard. Ask students to
write their own paragraph about what they have learned
about rainforests.

8. Assign each student a peer editor with whom they will
exchange papers. Give each editor a checklist to use as
they check their partner's papers for mistakes.

9. After editing, allow students to publish their writing using
Student Writing Center. Show them how to add their
saved Internet graphic. Allow students to print their work
and share it with a peer.

w

Assessment: Students will be assessed on their completed
sentences/paragraphs with a self-evaluation and a rubric.
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Writing Storyboard

Name Date

Peer Editor Graphic

Graphic:
File Name

Location

Write a paragraph about rainforests.
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Peer Editing Checklist

Author's Name

Editor's Name

Put a check in each box.
o Proper nouns are capitalized.
o The first word of each sentence is capitalized.
o Each sentence begins in a different way.
o Each sentence is complete (has a noun and a verb).
o There is a punctuation mark at the end of each sentence.
o Commas are used fo separate items in a list.

o Apostrophes are used in contractions
and possessives.

o Information clearly relates to the main
topic. It includes several supporting
details and/or examples.
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Student Self-Assessment
Name: Date:

Peer Editor: Project:

Use this checklist to carefully check your paragraph. Don't forget to double-check your
work!

o My paragraph clearly relates to the main topic. It includes several supporting details
and/or examples.

o I read the paragraph for meaning.

0 I checked the paragraph for complete sentences.
o I used correct principles of grammar.

o I used the spell-check tool on the computer.

o I double-checked for correct spelling.

o All sentences start with a capital letter.

o Proper nouns are capitalized.

o The title has capital letters where needed.

o Each sentence ends with proper punctuation.

o Commas and quotation marks are used correctly.

o I followed the procedures of the writing process: prewriting, drafting, revising,
editing, and publishing.

o I reread the paragraph carefully for all errors.

o I used 2 graphics in my published paper.

Day 1 inspiring, innovative, instruction Copyright © 2006 i3 Inc.
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Assessment

Name: Date:

0 The paragraph clearly relates to the main topic. It includes several supporting
details and/or examples.

o The paragraph was edited for correct use of capitalization, punctuation, and
spelling.

o Correct principles of grammar were followed.
o The writing process was followed: prewriting, drafting, revising, editing, and

publishing.

Teacher comments:

Student comments:

Day 1 inspiring, innovative, instruction Copyright © 2006 i3 Inc.
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Related
Resources

The Writing Process

Writing as a Process
From the time children learn how to write their first word, they begin to
build the skills needed to begin the writing process. These stages
include:

T Prewriting K Drafting K Revising M Editing & Publishing

It is not necessary for students o move through each of these stages in
order every time they write. Each stage can be taught and reinforced in
combination with other lessons and students should be free to write and
revise and revise again if necessary.

Students usually start their experience by writing personal narratives.
They can continue this type of writing as they get older by recording
experiences in daily journals. Students also enjoy writing imaginative
stories and responses to literature as they reflect on something they
have heard or read. They can also write content area pieces, which
report information that they have learned through research. Expository
writing is an essay to explain or persuade the audience. They can use all
of these writing styles in a variety of ways including letters, poems,
essays, editorials, reviews, travel brochures, postcards, character
analyses, and more.

Students need time each day to practice writing skills. They can write in
daily journals that can be used to communicate feelings and emotions
about things that are happening in their life. Students need a time each
day to write for various reasons. Writing should be integrated
throughout the curriculum as they write about science experiments,
create math stories, and explain concepts that they have learned in
Social Studies.

Technology can serve as a catalyst that students can use to do their

writing. Typing and editing stories on the computer can often take the
monotony out of a process that some students may find uninteresting.

Prewriting

Day 1
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See more story
sparks at
http://www.ange
Ifire.com/wi/wri
tingprocess/pre

writing.html.

For examples of
some of these
organizers, see
http://www3.sk.
sympatico.ca/fis

s/pre-writ.htm.

If Inspiration is
not available at
your school, you
can use one of
the on-line web
generators like
the one at
http://www.teac
h-
nology.com/web
tools/graphic

org/

All writing begins with some form of prewriting. In this stage, students
choose a subject and begin to organize their thoughts before they start
to write. If students are not assigned a specific topic about which to
write, they need o decide on one. You can use the following motivators
to spark student’s creativity:

o A group experience
An individual experience
A piece of literature
An unexpected happening
A common feeling
A question
A memory
A discussion

0 0000 0o

After students decide what to write, they need to organize their
thoughts using some sort of organizer. Students can use word charts,
story maps, webs, brainstorming individually or in groups, the class word
wall, a storyboard, note taking, outlining, or group discussions. As
students are working, they need to keep these questions in mind:

o Who is my audience?
What other ideas go with this idea?
Which ideas should be grouped together?
Where does each idea fit into the whole picture?
What do these ideas or phrases have in common?
In what order should these ideas appear?

0O 0O 0 0 D

Students can use technology in this stage of the writing process to help
them organize their thoughts in the form of a graphic organizer.
Inspiration software is an excellent source for outlining and webbing.

Drafting

Once students have organized their thoughts, they are ready to begin
writing. As students move from the prewriting to drafting stage, they
need to keep the following points in mind:

o You do not have to include all points from your prewriting in
your draft. Make sure that you pick your best thoughts and
that all the ideas relate directly to your topic.

o Keep writing! Once you start writing, don't stop to correct
spelling and mistakes in grammar. Just keep writing. You
can correct errors later.

o Don't worry about the length of what you're writing. When

Day 1
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For more
Drafting
suggestions, see
http://www3.sk.
sympatico.ca/fis
s/first.htm

Several methods
that students
can use to
complete the
revision process
are found at
http://www.ange
Ifire.com/wi/wri
tingprocess/revi

sing.html

you feel that you have explained all of the ideas in your
writing, you are ready to go to the next stage.

o Reread what you have written to make sure there is enough
content before going on to the next stage. If you haven't
explained your topic fully, go back to your prewriting for
more ideas and details.

0 Make sure that you use illustrations and details that will
catch the reader’s attention.

Poor writers can be paired with a peer tutor for extra help during the
drafting process for extra support. When students are working on their
draft, the teacher should be available to conference with them.

Technology can be used to assist in this stage, but it may be easier for
students to write their draft on paper before entering it in a word
processor. This frees them to concentrate on what they are writing
instead of worrying about the formatting and typing.

Revising
Revising is not the same thing as editing. When you edit, you check for
errors in grammar and spelling. When you revise, you look at the meaning
and the way that your ideas are presented. In the revision stage,
students need to make changes, additions, and deletions. It is important
to note that revision is not for editing conventions of spelling and
grammar. When it is time for students to revise their work, the
following checklist can be used:

o Can you read it aloud without stumbling over words?
Do all of your sentences relate to the topic?
Does the sequence of events make sense?
Are descriptive words used to describe characters or events?
Do you have a catchy introduction and conclusion?
Are you using the same words over and over again?
Are all of your sentences complete?

0O 000 D0 O

Students often need help completing this stage of writing. Conferencing
can give students the feedback that they need to make changes and
revisions. Students may conference with another student or the
teacher. Younger writers should begin their revision process with a
teacher conference, while more experienced writers can use peer
conferencing. Once students are old enough to conference with peers,
you need to teach them rules and procedures. Peer conferences can also

Day 1
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You can create
your own editing
checklist at
http://www.4tea
chers.org/projec
tbased/checklist
.shtml, or use
the one provided
at
http://206.218.1
28.2/laintech/pe
er.htm.

Proofreading
Chart-
http://www.ange
Ifire.com/ks/tea
chme/editingcha
rt.html.

For more tips on
editing, see

http://www.ange
Ifire.com/wi/wri
tingprocess/edit

ing.html.

be modeled for students to show them how to interact effectively with
their peers and give constructive criticism. Initial peer conferences may
be centered on a checklist that each partner completes to evaluate the
writing.

Not all writing needs to go through the revision process. Students may
abandon a piece of writing because of poor choice of topic or lack of
interest. Just monitor students’ progress to make sure that some of
their writing does go through all five stages.

Editing

The editing process focuses on making changes to grammar and spelling
conventions. If students are beginning writers, they need to focus on one
or two areas to edit such as capital letters or the use of punctuation.
More experienced students can focus on more areas. Proficient writers
can conference with other students and provide proofreading support
for each other.

Some tips for successful editing:

o Encourage peer editing for older students, which promotes
collaboration among peers.

o Use a student-editing checklist to aid students in looking for
errors.

o Teach students proofreading marks and display a chart in your
room for quick and easy access.

o Teach students how to use the spell checker and thesaurus that
are built into the word processor.

o Some word processing programs are capable of text-to-speech,
which gives students the chance to hear their writing read back to
them. This will help them see if their sentences "sound right".

o Younger students should refer to classroom word walls when
checking for spelling errors.

Publishing

Once students have invested their fime and energy into going through
each step of the process, they enjoy publishing their work and seeing
how other people respond to their writing. Not everything that starts
with prewriting needs to make it to the publishing stage.

Day 1
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Places for
students to
publish on-line:
http://www.liswa
.wa.gov.au/funho
use/kidswrit.ht
m:
http://www.kida
uthors.com/;
http://www.veec
eet.com/

Locate e-pals on
http://www.keyp
als.com/ or
http://www.epal
s.com/.

There are many ways for students to publish their writing. Listed below
are just a few:

o Ask students o record their writing onto an audiotape or
videotape. This is an excellent addition to a child's portfolio and
can show growth in reading and writing throughout the year.

o Make a book of students’ writing. Allow students to create a cover
and bind the book with a ring binder.

a Publish student writing in a school or class newspaper.

o Feature stories on a bulletin board and allow students to visit the
board to read peer’s writing.

o Create a multimedia presentation with illustrations using KidPix,
Power Point, or Hyperstudio.

o Type a final copy onto a word processor and jazz it up with
borders, clip art and special fonts.

Allow students to post their writing on-line.
Allow students to work with a group to dramatize a story that
they have written.

o Have students send their completed writing over e-mail to a
parent, e-pal, friend, or teacher.

Day 1

inspiring, innovative, instruction Copyright © 2006 i3 Inc.




Curriculum & Technology Integration Training -23-

Google Earth

To download a free version of Google Earth go to the url below and click on "Get Google
Earth”
Then say yes & next to all the questions and you will have the software.

http://earth.google.com/

= Google Earth
File Edit View Add Tools Help

[ My Placah

¥ % civil Wir Battlefields

ice §k for more
overlays and image

» [ & ~cE3fkmz

"Google

3

Polnter 0°00'00.00° N 0°00'00.00° E Streamingi(|]][I11]] 100% Eye alt 8421.02 mi

l== Lodging I {'{ Dining @ @
Roads i [ Borders ; Oxs % @
¥ 5\ Terrain v @ Buikdings e @ e 6 @ K
Sear ch for \
Saved locations or
13 ti %Vw
. P|61|C&3c-jed Fly To Layers Zoom in or Movethe
;Wgnfg o downloaded out world Tilt for fly éld d Placef:,
or entered N-S-E-W overs acemar
e st " e View menu is where you can turn the following on & off; compass,
View stze . latitude & longitude grid. Y ou can also adjust the screen size here.
w Compass
w Status Bar

Lat/Lon Grid Cirl+L

Overview Map  Ctri«M

Play Tour F10

~[ s
» [_]& Civil War Battlefields

» []ED bergen
» []ED pamocLEs

Please visit hitp:ifw ww.seaice dk for more

overlays and image data

b [1& -GE3FKmz . . . . . . X .
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Thisiswhere your saved and downloaded “Places’” are located. They
can be turned on & off by putting a check in the box to the left of the
folder or “placemark”.

+ Places

= My Pl k -
'Fg by PacEs e

3 [ bergen
« [ |53 pAMOCLES
Plzase visit hitp:/'www .seaice.dk for morgs
overlays and image data
- D 3 PolarView
European Space Agency's GMES Servi
Element =upports the Eurcpean
D@ PolarView
D@ AMSR-E Total ice concentration
Parameters calculated by an optimal
- ﬂe&timatiun technigue from AMSR-E

(X&)

_ Thisiswhere your saved and downloaded “Layers’ are located. They
E1 f oo e 5 can be turned on & off by putting a check in the box to the |eft of the

D & Cri”-1Pc|int5 of interest and other featu

[ [ census folder or “placemark”.

I:‘ * US Congressional Districts
) [ Populated Places
) [ Geographic Features
»[¥] B2 30 Buildings

I:‘ D water
) [ Earthquakes

I:‘ @ Volcanoes
)I:‘ B e Coverage - 2005
)I:‘ B e Coverage - 2004
)I:‘ B e Coverage - 2003
)I:‘ B pe Coverage - 2002

Notes:
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Daily Diary

Name:
Date:

Everyday you will be instructed to complete a "Daily Diary" entry. You will
find the diary topic on the electronic bulletin board every morning. After
you have written in and saved your diary, you will need to print 2 copies, one
for your folder and one for your book.

Today's "Daily Diary” is

What are my reasons for being here? What do you hope to gain from
this experience? How do you envision your classroom changing with the
use of technology?
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Classroom E-Mail Activities

E-mail has opened up a whole new world of communication that links adults and children
internationally. Because e-mail has become such an
integral part of communication, it is important that
students be given the opportunity to share ideas and
thoughts with their neighbors around the world. Here
are some suggestions for using e-mail in your
classroom:

o Find an e-pal from another state or country and
exchange information about cultural
differences. Locate e-pals on
http://www.keypals.com/ or
http://www.epals.com/.

o Send weekly e-mail messages to all students that include your weekly schedule,
reminders, homework assignments, and special project information.

o Allow students o e-mail writing projects to each other for peer editing. The
editor can make changes in red type and return the document to the author.

o Students can share writing, thoughts, or technology projects with parents and
guardians by attaching them to an e-mail message.

o E-mail experts to ask questions students formulate about content area subjects
and units of study. http://www.refdesk.com/expert.html

o Participate in on-line collaborative projects with other schools.

o Communicate with congressional leaders in Washington at
http://www.mrsmith.com/index2.html.

o Ask students o write fan mail to their favorite athlete or sports feam. You can
locate e-mail addresses for most sports teams and athletes on their homepages.
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Software Helper
Creating a Password Chart in MS Word

The goal of this assignment is to create a chart for passwords using Microsoft Word. It is a good idea to
keep a record of passwords for any Internet account or service for which you register.

Steps to Create a Password Chart

1. Start the program Word.

2. Type in the heading “Password Chart."

3. Return twice.

4, Select the "Table" button from the task bar at the top of the screen.
5. Select "Insert Table."

6. Type in the number "3" by the Number of Columns.

7. Type in the number "15" by the Number of Rows.

8. Click the Auto Format Button.

9. Scroll down the Format column and click on the Grid One format.

10. Click Okay.

11. Verify that you have entered 3 and 15 and then click Okay again.

12. Click inside the top box of the first column. Type in the word "Account.”

13. Click inside the top box of the second column. Type in the word "User Name."

14. Click inside the top box of the third column. Type in the word "Password.”

15. Highlight the top row. Choose the Center format button on the task bar at the top of the screen.

16. Highlight the entire chart. Choose Format from the task bar at the top of the screen. Select
"Paragraph” and then select Line spacing. Select "I.5 lines." Enter.

17. Highlight "Password Chart.” Choose the Center alignment button from the task bar at the top of
the screen.
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Whole Group Learning with your PC

The Data Projector
This piece of hardware is quickly becoming the choice of educators for whole group
instruction in their classroom. The data projector is the equivalent of the movie
projector except instead of film being projected on the wall it projects what's on your
computer. These use to be so expensive that districts were lucky to have just one.
Recently manufactures have broken the $1000 floor on some models. Now it is not
uncommon to see new schools being built with these built-in to all classrooms. Even
though these can be purchased for under $1000 plan to spend about $1200-$1600 for
one of these for your classroom.

Web Resources:
http://www.becta.org.uk/teaching/pedagoqgy/technologies/projectors.html
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Software Helper

Windows Basics

The first screen that you see after starting your computer is called the Desktop. It is
where you do all of your work. There are certain items on your desktop that are there
to facilitate your work. These items can be customized to meet your own needs.

Items on the Desktop:

o My Computer- This icon enables you to have access to your hard, floppy, and CD
drives. You can also access your printers and the control panel.

o Network Neighborhood- Provides access to shared resources, such as printers and
networked computers.

o Recycle Bin- A temporary holding bin for files that you want to delete. Files placed
in the recycle bin can still be recovered until they are permanently deleted.

o Start Button- Provides access to the Start Menu. From the start menu, you can
access programs, documents, settings, help, and search options.

o Taskbar- This is the horizontal bar located at the bottom of your Desktop. All of
your open applications are shown on the taskbar and it enables you to move easily
between applications. The taskbar also displays the clock, the Start button, and may
house some shortcuts to programs.

Turning the Computer On and Off

To turn the computer on, check to see how the computer is plugged into the electrical
outlet. If the CPU, monitor, speakers, and printer are all plugged into a power strip,
simply turn on the power strip. If each part is plugged into a different outlet, turn on
the monitor first, then the CPU and finally the speakers and the printer.

To turn the computer off:
Close all programs, windows, and folders
Click on Start, and then Shut Down
Click on Yes.
Wait until the computer gives you the message that it is safe to turn of f the
computer.
Then either turn of f the power strip, or unplug the parts in this order: monitor,
CPU, speakers, printer.

Executing a Program
» Click on Start and drag the arrow to Programs.
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> Draw the pointer o the folder where the program resides and to the name of
the program.
> Click to start the program.

Installing a Program
Most CDs will automatically open up in the Install Mode. You will simply follow the
on-screen instructions. If it does not, follow these steps:

Click on Start.

Drag the pointer to Settings, then click on Control Panel.

Double-click on Add/Remove Programs.

Click on Install.

Insert the CD or Disk into the drive.

Click on Next.

Follow the on-screen directions.

To Create a Folder on the Desktop:

Right click anywhere on the blank desktop.

Click on New and then on Folder.

Type in the name for the folder. (Example: name it "Applications”)

Press Enter

A folder entitled "Applications” should appear on the desktop.

YV VYV V VY
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To Create a Shortcut to a Program:
A quick and easy way to access programs is by making a shortcut on the desktop or in
your applications folder.
> Double click on the Applications folder to open it.
Click on File, then New.
Click on Shortcut.
Click on Browse (you may need to change the drive to "C")
Find the program for which you want to make a shortcut (for example KidPix
Studio)
Look for the file name that has .exe at the end (Picker.exe)
Click on Picker.exe and then Open.
Click on Next and type a name for the shortcut. (KidPix Studio)
Click on Finish.
Find your new shortcut and test it out by double clicking on it to open the
program. Close the program by clicking on File and Quit.

YV V V V
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To Format a Disk:
Most new blank disks will not need to be formatted. In the case that it does:

> Double-click on My Computer.
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To Co
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Insert a floppy disk into the "A" drive.

Right click on the "A" drive icon.

Click on Format, under Format Type, click on Full.

Click on Start.

Click on Close.

Close the My Computer window.

a Disk:

Double-click on My Computer.

Insert the disk you want to copy into the "A" drive.

Right click on the "A" drive.

Click on Copy Disk and then Start.

When the message "Insert the Destination Disk”, put the blank disk to want to
copy to into the "A" drive.

Click on OK.

Click on Close when you get the message, "Copy Completed Successfully.”
Close the My Computer window.

To Create a System (Start Up) Disk:

>
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Double-click on My Computer, then on Control Panel.
Double click on Add/Remove Programs.

Click on the Start Up Disk tab.

Click on Create Disk.

Insert a disk into the A drive.

Click on OK, then OK again.

Click on the X in the title bar to close the Control Panel
Close the My Computer window.

To Rename a Folder or File:

>

>
>
>
>
>
>

Double-click on My Computer.

Double click on the drive that contains the folder or file to be renamed.
Click on the file you want to rename and then click again (softly).

This will highlight the old name and a cursor will appear.

Type in a hew name.

Press Enter.

Close the My Computer window.

Deleting a File or Folder

>
>
>

Double click on My Computer and the drive in which the folder is located.
Click once on the item you wish to delete and highlight it.
Press Delete on the Keyboard.
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> Tt will go to the Recycle Bin, you can retfrieve it until you permanently delete
it.

> To retrieve the item, double click on the Recycle Bin, and click on the folder
you wish to restore. Click on File, and then Restore. It will return to its
original location.

Moving a Window
» Inan open window, click on the Title Bar and drag the window to the desired
location.

Resizing a Window
> Put the pointer on the lower right corner of the window ( you will see a
diagonal arrow). Click and drag to make the window smaller or larger.

Copying and Moving Files
> Double click on My Computer and then on the drive where the file is located.
Double click on the drive where the file is to be moved or copied.
Move the open windows so you can see both of them clearly.
Find the file you want to copy and click on it.
If you are copying a file, click and drag the file to the appropriate drive. You
will now be able to access the file in both places.
If you are moving a file, hold down the Shift key as you drag and drop the file.

YV V V V
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Playing an Audio CD

Open the CD ROM drive by pressing the button.

Insert your CD.

Press the button again to close the door.

The CD should begin playing automatically.

The CD player will be shown on the taskbar.

Click on the CD player to open the window.

Place the arrow on the various buttons in the CD player to see the different

options.

The "Stop"” button is the black square, the "Play” button is the black triangle.

Click on the "Minimize" button (-) to place the CD Player back on the Taskbar.

> Click on the "Close"” button (X) to exit the CD Player. (Be sure to stop the CD
before you exit.)

VYV VYV VY VYV
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Volume and Sound Controls
There are two places to adjust the volume:

Check to make sure that the speakers are turned on and plugged in.
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> Click on the speaker icon in the lower right hand corner of the Taskbar.

> Move the lever up or down to adjust the volume accordingly.

> Click on Start, drag to Programs, Accessories, Multimedia, Volume Control,
and click. Adjust the volume in the same way.

Changing the Desktop Wallpaper (Background):

>

Y V V VY

>

Right click anywhere on the blank desktop.

Click on Properties.

Click on the Background tab if it does not come up automatically.

Under Display, click on Tile.

Under Wallpaper, click on the various patterns you can use on your desktop.
Select one that you like and click on it.

Click on Apply and then OK.

Changing the Screen Saver:

>

YV VYV VY VYV

>

Right click anywhere on the blank desktop.

Click on Properties.

Click on the Screen Saver tab.

Click on the down arrow to see a list.

Click on the various screen savers, find one that you like and select it.

Click on Preview.

Click on the screen to return to the Properties window.

Choose how long you want your computer to be idle before the screen saver
comes on. Choose 1 minute in the Wait option.

Click on OK.

To Change the Number of Colors that the screen uses:
If your computer should give you a message stating that the program you are
trying to run only runs in 256 colors, follow the directions below.

>
>
>

Right click anywhere on the blank desktop.

Click on Properties, then on Settings.

Under Color Palette, select 256 colors and in the desktop area, the setting
should be 640x480 Pixels.

Click on OK.
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Software Helper

Introducing XP Things You Might Like to Know

Microsoft Office XP software is full of features and options. Although many of the
features have been in the MS Office software for a while there is some new

functionality in this version.

Task Pane

Task Pane is a new feature in Microsoft XP
Software. It puts key commands in a panel on
the right side of the computer screen. It is
specific to the software that you are using so
the PowerPoint Task Pane is different from
the Word Task Pane although there is some
overlap. One nice thing about Task Pane is
that it makes visible some options that people
might not otherwise find, like templates.

@ Left and right arrows in the tan bar at
the top of the Task Pane window let's you
switch to other lists of commands.

@ The drop down arrow in the tan box at the
top of the task pane let's you see a list of
menus that are available.

# The X button in the tan box let's you close
the task pane and gives you a larger
screen space.

@ To prevent Task Pane from opening when
you start a program, click on the View
menu and remove the check next to Task
Pane. Another option is to remove the
check next to Show at Startup at the
bottom of the New Document Task Pane
window.

< New Docur ™ X
Open a document
PowerPoink 2000- T
PoweerPoink 2000- T
PPT Presentation e
Excel Z000- Making
= More documents. .,

Mes
[ Blank Docurment
@ Blank web Page
= Blank E-mail Messag

Mew from existing
docunment

E_j Choose docurnent. .
Mew from template

| ] General Templates,

% Templates an s W

L5 ] Templates on Micro:

[T Add Metwork Place.
@ Microsoft YWiord Help

e |

w| Show ak skartup ‘
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Start Button

In XP the interface under the Start button has been redesigned. Things like My
Computer and My Documents are now available under the Start Button. Control panel
also has been re-organized and given a new look,

Smart Tags

In this latest version of the software, XP attempts to further sense and
respond to what you are doing in a document. If you perform an operation that could be
handled more than one way, a smart tag appears. When you click on the smart tag your
options appear and you can just click on one of them. For instance, if you are pasting
text from one document into another a smart tag will appear. What it wants to know is
if you want to keep the same formatting or match the pasted text to the formatting of
the destination document. Whenever you do something that could be completed in more
than one way you will see a smart tag.

Double Down Arrow

The standard tool bar has drop down menus. When you click on the File menu it drops
down so that you can see what is in it. A change has been made in this version of XP
where they show you the most commonly used items on the menu and then hide the rest.
On the bottom of the list is a double arrow pointing down. Click on it to expand the list
and see everything in the menu.

If you would rather see everything each time click on the Tools menu and then on
Customize. Under the Options tab place a check next to Always show full menus. When
you click OK, that changes your menus. They will now open completely each time.
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General Word Processing Tips
Only hit return at the end of a paragraph.
Avoid using all caps.

Titles should be larger than the body of your document and can be in sans serif font.
Be creative with your style.

Rarely underline. Use italics for titles.

Use tabs to align text- not the space bar!

Indent or use space between the paragraphs- but not both.

Add pizzazz to lists by adding bullets or symbols.

Generally, use not more than two fonts on a page.

Use italic and bold as rich desserts- fine occasionally, but easy to overdose.

For signifying A.M. and P.M., use capital letters, periods, and font one size smaller
than the rest of the document.

Avoid abbreviations in addresses, except for states.
Allow for white space in your document.

To avoid widows and orphans, try making your top and bottom page margins and/or
your font smaller.

Use a spelling checker.

> Always proofread a printed copy of your work.

» Printa duplicate copy of your work in gray scale, so you can see how it will look if you

plan to duplicate it on the copy machine.

Copyright © 2001 - 2006 i3 Training Services Inc. inspiring, innovative, integration Day 1



Technology Tools in the Secondary Social Studies & Language Arts Classroom 37

Standards Based Instruction

Are you a standards-based teacher? Are you aware of what your students are required
to know when they leave your class by the end of the year? What process do you have in
place to help manage your standards based instruction?

This activity is designed for self reflection about how you manage your standards based
classroom. We will dialogue abut the following sections and questions below.

http://www.michigan.gov/mde/0,1607 ,7-140-28753 33232---,00.html

Grade(s) you teach?
Subject(s) you teach?

List 3 areas in your curriculum (to the standard) where you &/or you students seem to
be struggling.
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Web Harvest Sheet

Use this sheet to record URLs that you want to
remember for later use.

URL Title Description
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